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 There are numerous music centers for you to enjoy

 songs, like iTunes, Google Music, Amazon, Billboard etc. As iOS

 devices users, you can easily enjoy and download music from

 iTunes. And what if you wanna download music to iPad from Google

 Music, Amazon or other music sites? Here you can get some

 hints:

 

 

  

 

 

 It's not a tough work for you to listen to music on

 Google Music or Amazon music on iPod, iPhone or iPad. You can

 directly install the apps to achieve your aims. (If you only want

 to use Google music on iPad, iPhone or iPod, you can click the

 link to get more info: Google music on iPad.) But if you wanna

 download the music or music video from those media sites

 including YouTube, Google, Amazon, Facebook, you can download a

 professional music downloader to help.

 

 

  

 

 

 Useful resources:

 free

 ipad movie |

 ipad

 music |

 ipad

 songs
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 Rip

 DVD to AVI can help DVD fans to rip DVD video and convert to

 popular AVI video format. It supports all types of DVDs including

 normal DVDs, CSS protected DVDs, commercial DVDs, Sony ArccOS

 DVDs, all region 1-6 DVDs. Except AVI, it also support most of

 popular video formats such as FLV, MP4, WMV, MOV, MPEG1/2 as

 output video formats. You are also allowed to extract DVD audio

 to MP3 music file and grab images from DVD to BMP, JPEG. It

 offers a comfortable interface to carry out DVD to AVI ripping

 operations as easy as possible. The application completes the

 conversion pretty fast and with little impact on system resources

 compared to software of the same kind.

 

 

  

 

 

 Download

 and install this

 free dvd ripper (

 free

 dvd ripper for mac) on your PC, launch it after installation.

 Bellow is one step-by-step instructions of how the "Convert DVD

 to AVI" works:

 



 

 

   Choice

   your DVD driver and insert your DVD disc;

 

 

   Click

   "Read" button;

    (if your DVD disc is ready, program will read all the

   video clips on your DVD disc)

 

 

   Choice

   one video clip;

    (you can click "Preview" button to view the video clip,

   program will show one standalone window to play)

 

 

   Select

   the output AVI video format;

    (the default AVI video format is DivX, you can change

   this setting and choice any format that you want. DivX codec

   uses lossy MPEG-4 compression, where quality is balanced

   against file size for utility.)

 

 

   Click

   "Convert" button to start the conversion;

    (program will need you to select one folder on your pc

   as the output folder, the output AVI files will be saved in

   this folder. Please make sure that there is enough space on the

   target disk)
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 Whether you want to watch a movie on your iPod or

 back up your too-easily-scratched DVDs, DVD ripping is a

 mysterious realm for many. Even those in-the-know find it

 difficult to keep up with the best tools for the job, especially

 in the face of increased copy protection. Today we offer you the

 best dvd ripper

 software and

 free

 dvd ripper mac.

 

 

  

 

 

 Handbrake is a

 dvd

 ripping software with a strong emphasis on not just ripping

 media but recoding it for playback on computers, portable

 devices, and other non-disc based systems. Handbrake can help you

 convert DVDs and other MPEG-based video into MP4 and MKV files.

 You can tweak settings like video frame rate and audio codec

 playback to your heart's content with Handbrake, and even batch

 encode all your media at one time to make filling up your iPod or

 other device relatively painless. The one major shortcoming of

 Handbrake is that it doesn't have any copy protection removal

 tools built in, which means you may occasionally need to use a

 3rd-party stripping tool to prepare your DVD for

 conversion.
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 Lets face it guys, If you're a gamer, not a fake

 but a REAL gamer, the kind that can seat like 48 hours in front

 of the tele and burn those long and curvy high speed race tracks

 all the way to the victory, or feel that you're the only true

 mighty fighter on earth that can easily save his planet while

 busting those mudda fucka ugly aliens that invaded from out of

 space a few hours ago - if you're that guy/gal - then you should

 know.You will like to play the

 ipad 2

 games.

 

 

  

 

 

 1.Checkers Free HD

 

 

 It's checkers. On an iPad. For free. What more do

 you want to know? Oh, OK, then - Checkers Free HD is a pretty

 decent version of the popular board-game, with a variable

 difficulty level, configurable player names, an 'undo' function

 for wusses, and a toggle for forced captures.

 

 

  

 

 

 2.Compression HD

 

 



 Compression HD is roughly what you'd end up with if

 you used a hammer to smash Puyo Puyo into the garbage compactor

 scene from Star Wars. Pieces fall, and you move and rotate them

 to fashion lines of three. All the while, the walls are closing

 in.

 

 

  

 

 

 3.Dizzypad HD

 

 

 Dizzypad is a one-thumb game which has you tapping

 the screen to have your frog leap between rotating lily pads. If

 he falls in the drink, he dies (pollution, eh?), but extra lives

 can be gained by munching bugs or bravely skipping lily pads.

 Extra modes are available via in-app purchase.

 

 

  

 

 

 4.Harbor Master HD

 

 

 This game might look like Flight Control in the

 drink, but the gameplay mechanics are subtly different. As with

 Firemint's effort, Harbor Master is a line-drawing game, this

 time with you drawing paths so boats can dock. However, once

 they've unloaded, they must leave the screen or sometimes visit

 another dock, ensuring things rapidly become complex and

 frantic.

 

 

  

 

 

 5.Hole-in-a-wall HD

 

 

 Hole-in-a-wall HD is pretty much the space-age

 equivalent of that Saturday evening TV show where daft people try

 and fling themselves through holes in a wall. Here, though, you

 swipe to rotate a shape, aiming to fit it through a very specific

 gap. The game doesn't come off flawlessly (it's often hard to



 judge alignment as the wall zooms towards you), but perseverance

 reaps rewards.

 

 

  

 

 

 iPad help: put

 dvd to ipad |

 dvd to

 ipad reviews
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 Christmas is coming,I collected some Christmas

 songs.If You have an ipad 2,Put them to your ipad 2.This is such

 a beautiful thing.

 

 

  

 

 

 1 White Christmas Bing Crosby 2 The Chipmunk Song

 The Chipmunks 3 Rudolph, The Red Nosed Reindeer Gene Autry 4 I

 Saw Mommy Kissing Santa Claus Jimmy Boyd 5 Jingle Bell Rock Bobby

 Helms 6 The Christmas Song Nat King Cole 7 Snoopy's Christmas The

 Royal Guardsmen 8 Here Comes Santa Claus Gene Autry 9 Little

 Drummer Boy Harry Simeone Chorale 10 Donde Esta Santa Claus Augie



 Rios 11 Rockin' Around The Christmas Tree Brenda Lee 12 You're

 All I Want For Christmas Brook Benton 13 Baby's First Christmas

 Connie Francis 14 Santa Claus Is Coming To Town Bruce Springsteen

 15 Home For The Holidays Perry Como 16 Santa Claus Is Coming To

 Town Four Seasons 17 Do They Know It's Christmas Band Aid 18

 Happy Christmas (War is Over) John Lennon and Yoko Ono 19 May You

 Always Harry Harrison 20 Grandma Got Run Over By A Reindeer Elmo

 and Patsy

 

 

  

 

 

 Related help:

 transfer

 songs from ipad to itunes |

 transfer

 ipad music to mac |

 transfer

 songs from ipad to mac
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 Just as Apple Inc says: "the iPod touch is music,

 movies, games, and apps. All at your fingertips". Indeed, as a

 portable media player, personal digital assistant, and WIFI

 mobile platform, Apple has sold 20 million unit as of September

 2009. The iPod Touch is currently in its third generation (3G),

 which is available with 32, or 64 GB of flash memory. So powerful

 storage capable attracts more and more guys to import

 dvd to ipod touch for

 watching DVD Movies on iPod touch...

 

 

  

 

 

 The software you will need:

 ipod

 dvd converter or

 ipod

 touch converter

 

 

  

 

 

 Step 1: Load DVD movies into the program.

 

 

 1. Right click the "DVD/CD" node in the left

 panel.

 

 

 2. This program supports DVD disc, ISO file,

 and IFO file. You can load DVD movies by "Open DVD" (DVD

 disc or DVD folder), "Open ISO Files...", "Open IFO

 Files...".

 

 

  

 

 

 Step 2: Rip and put DVD movies into iPod.

 

 

 1. Check files you want to sync.

 

 



 2. Click "Export Checked File(s) to Device" button

 to start your conversion process.

 

 

 After a few minutes or so, your DVD movies will be

 put into your iPod.

 

 

 OK, done.
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 The following article focuses on different channels

 of listening to music on iPhone 4S. To enjoy music on iPhone 4S,

 you first need to get the music in iPhone 4S format onto iTunes

 library(tip:

 transfer

 iphone to new computer) and then sync the music to your

 iPhone 4S.

 

 

  

 

 

 Step 1. Click "Back Up My Music & Videos to

 iTunes".

 

 



 The blue icon means the file is in iTunes library.

 You can check "Show files not on iTunes only" to filter files

 that are not in iTunes. If you have a bunch of media files on

 iTunes, ou can search for any file by typing its name in the

 Search blank.

 

 

  

 

 

 Step 2. Select the music/videos you want to backup

 and click "Back Up".

 

 

 After finished, click "OK'.

 

 

  

 

 

 Note: Your iPhone 4S contents will be copied to

 iTunes and computer simultaneously. The default computer output

 path is *.My DocumentsiMate. If you want to back up

 iphone

 playlist to itunes to a specified place, you can click

 "Settings" and set the output path as below:

 

 

 All right, now you have transferred iPhone 4S to

 iTunes.

 

   Similarly, you can use the way to

  

   transfer ipod to

   pc.
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 Need some ideas for Christmas games for kids?

 Whether you're hosting a Christmas party for kids at home,

 school, or church, here are some great ideas for games for kids.

 These holiday games are also excellent for family gatherings,

 when kids of all ages are looking for ways to have fun. Party

 on!

 

 

  

 

 

 1. Visit your local store and purchase a candy jar.

 Fill the jar with candy goodies like colored M and M's, gum drops

 etc. Ask the

 

   kids

  to guess the amount of candy in the jar. Everyone only

 gets 1 guess and the person whose guess is closest to the actual

 amount wins the jar of candy.

 

 

  

 

 

 2. This is a traditional

 

   Christmas

   game for kids.

  Wrap a Christmas gift in several layers of paper before

 the party begins. You can have as many layers of wrapping paper

 as there are kids. Fasten each layer with tape. To play a game

 everyone sits in circle. Play music while passing the parcel

 around from person to person in the circle. As soon as the music

 stops, the person holding the parcel removes as many layers of

 wrapping paper as possible. Then play the music and begin passing



 again. The person who removes the last layer of wrapping paper

 wins the game.

 

 

  

 

 

 3. This fun and

 

   simple

   Christmas game for kids

  requires a different types of hats, coats and scarves

 and whatever accessory you can think of that a snowman might want

 to wear. Throw everything in one large pile and separate the kids

 into groups. Play Christmas music in the background as the race

 begins on who can dress their snowman the fastest is the

 winner.

 

 

  

 

 

 Related search:

 ipad

 movies |

 ipad

 to mac transfer |

 dvd ripper
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 There are many iPad apps available in the web but

 finding ones which are useful at the same time stable, is not

 easy. Because we have already made it our concern to find

 something anything useful, we decided to share with you the best

 iPad entertainment apps for your amazing tablet. These iPad apps

 are not only the best but also very popular in the web now. We

 hope that these article can help you in your search for apps that

 truly rock! If it does please share this article to your friends

 so that they too can have these apps.

 

 

  

 

 

 1. Yahoo! Entertainment

 

 

 This is a great free application from Yahoo that

 provides you with a lot of information about any TV shows that

 are currently airing or are about to air. You can plan your TV

 viewing using the interactive Program Guide, watch free videos

 provided by Yahoo and read the latest news in any category using

 this iPad application.

 

 

  

 

 

 2. ABC Player

 

 

 ABC Digital has thankfully jumped on the whole

 Internet TV bandwagon (a lot of other companies are also doing

 it) and not only have they created an online streaming channel,

 but also released their own apps for desktop computers, and now

 the iPad. Kudos to them, because thanks to this app, you can

 freely stream their channel right onto your iPad at very good

 quality and speed, and watch some of their best shows (and sadly,

 commercials) whenever they air.

 

 

  

 



 

 3. Marvel Comics

 

 

 Marvel's comic reading application or the iPhone

 has become very popular, but due to the small screen, it's not

 that comfortable to read the comics on it. Now the iPad is in a

 totally different league. With its large screen and

 1024×768 resolution, you can easily view and read full page

 comics in a comfortable manner, like you were reading the actual

 paper magazine.

 

 

  

 

 

 4. Ocean Blue

 

 

 Ocean Blue is an excellent application (some people

 call it a game) for relaxing and learning a lot about aquatic

 life. The game has excellent 3D graphics of underwater sceneries

 and fish, and you learn about them as you sort of swim along

 them. Children also love it and it's better for their brain than

 some shooters or even racing.

 

 

  

 

 

 5. Mixr

 

 

 This is an amazing unique (for now) application

 that replicated the function of a DJ turntable! Thanks to the

 iPad's great touch screen, you no longer have to spend $2000 for

 a turntable to create a nice DJ mix party at your home or local

 club. And in conjunction with other apps, the functionality can

 be extended by a very high degree.

 

 

  

 

 

 Related tag:
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 video converter for mac |
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 With the benefit of iOS camera, we do like to

 record those beautiful scenes in our lives. But problem is there

 are numerous fabulous still photos in our iPhones, iPods or

 iPads, but the memory of these iOS devices are limited, so how

 can we free the space without deleting them? That's to say, if

 you want to

 transfer

 photo from iphone to pc without losing original pictures in

 iPhone/iPod/iPad, what's the next step? This article gets an

 answer - you need a third iPhone photos transfer.

 

 

  

 

 

 Step 1: iPhone 4S to PC Link

 

 

 When you have downloaded and installed this

 iphone



 to computer transfer on your computer, you should first get

 iPhone 4S to PC link done before you run this program. After you

 have get your iPhone 4S connected with your local computer, you

 can just start to operate the software.

 

 

  

 

 

 Step 2: Pick up Image Files on iPhone 4S

 

 

 This step is designed for you to choose files for

 transferring. Under "Photo" and "Camera" options can you get

 access to image files on iPhone 4S, just open each option and

 choose files.

 

 

 

    

 

 

 

 Step 3: Copy iPhone 4S Photos to Computer

 

 

 This step is for you to transfer photos from iPhone

 4S to computer/PC: directly drag and drop the selected files to

 computer, or right click on the selected image files and

 "Transfer to" computer, or click on the Transfer button to

 transfer pictures from iPhone 4S to computer in "Transfer to

 list".

 

 

  

 

 

 If you have an iPod,

 how

 to put youtube videos on ipod? Please contact me.
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 The iPad 2 release date is March 11th. As one of

 the most amazing tablet in 2011, iPad 2 will take us more

 enjoyment on enjoying photos, watching videos, listening to

 music, reading e-books and much more. Enjoy videos on iPad

 2 should be your first choice. With the iPad 2, you can

 watch video anywhere, anytime, if you have a long air travel,

 watching movies on iPad 2 makes the time shorter. The most

 common movie format is DVD, Maybe you have many DVD Discs, But

 it's hard to take, and the iPad 2 can't play all

 formats video include DVD, just have a look.

 

 

  

 

 

 Step 1: Run

 free dvd ripper

 software, and load DVD movie files into it.

 

 

 Three ways are available to load DVD movie files,

 including "DVD Rom", "DVD Folder" and "IFO/ISO" icon.

 

 

  

 

 

 Step 2: Select subtitle and audio track

 

 

 Click on the dropdown menu of "Subtitle" and



 "Audio" respectively to select your needed languages as final

 output subs and audio track.

 

 

  

 

 

 Step 3: Choose output format for iPad 2

 

 

 To do DVD to iPad conversion via

 dvd

 to ipad 2 converter, you just need click on the drop down

 menu of "Format" to simply choose an output format for iPad 2

 from "iPad" option.

 

 

  

 

 

 Step 4: Rip DVDs to iPad 2

 

 

 Click the big button "Convert" to

 rip

 dvd to ipad 2 compatible file format. Once the DVD to iPad 2

 conversion is done, you can click "Open" button to get the output

 files for playing/watching on iPad 2 with ease. Hope it

 helps.
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 Sometimes using iTunes seems very difficult as we

 got feed up of the interface and slow speed, so today I am going

 to share a new trick as a step by step procedure to

 copy

 files from ipod to pc without using iTunes.

 

 

  

 

 

 Firstly, Download

 ipod to pc transfer and

 fire up the software. Then, the following main interface pops

 up.

 

 

  

 

 

 Step 1: Connect iPod

 

 

 Dock iPod and open it, connect iPod to your

 computer through USB cable.

 

 

 The software will automatically detect the iPod,

 display all the contents of iPod in the left device list and show

 its device info on the right window.

 

 

  

 

 

 Step 2: Select songs

 

 

 Locate the library or playlist in which your songs

 stayed and check the songs to be transferred in the file list on



 the right window.

 

 

  

 

 

 Step 3: Copy songs back

 

 

 Click the "Export to Local" button to select the

 target folder for saving iPod files in the dialog that appears,

 and then start to

 transfer

 music from ipod to pc.

 

 

  

 

 

 Step 4: Eject

 

 

 From the File menu, choose Eject and Eject

 All.
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 iPhone 4 is a mobile phone, a portable email



 device, a Web browser and an iPod. It is also capable of showing

 full-length movies. While the screen is tiny, the resolution is

 good, and you can plug in your earphones and watch and listen

 away. Once you start, you won't want to stop

 watch

 movies on iphone 4.

 

 

  

 

 

 1. Download the latest

 dvd to iphone 4

 converter. Install and run it.

 

 

 2. Click the "Open DVD" button to load the DVD

 movie. Alternatively, you can click "File -> Open DVD..." to

 import the DVD disc. After the DVD is imported, there will be a

 list of DVD titles showing in the program.

 

 

 3. Tick the longest DVD title from the list. Double

 click this title and you will preview the movie in the

 program.

 

 

 4. From the "Profile" drop-down list, navigate to

 the "Apple iPhone" category and choose the most appropriate

 output format for your iPhone. Note: You can also customize a

 specific profile to meet your needs. Click here to learn

 more.

 

 

 5. Click "Start Encode" to start to

 convert

 dvd to iphone 4 video.

 

 

 6. Add the output files to iTunes and sync them to

 your iPhone 4.
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 The iPod is probably the best portable music player

 the world has ever seen. It's simple to use, easy to operate, and

 instantly updatable. It's easy to take this beautiful and

 reliable device for granted. But the iPod isn't perfect. One of

 our pet peeves is the inability to transfer an iPod's music back

 to a computer. There are a handful of nice applications you can

 use to take back control of your iPod.

 

 

  

 

 

 

 iPod to Mac

 Transfer is a Mac OS X application that compensates for the

 iPod's only downside: Apple only allows you to copy songs to your

 iPod. If you have two Macs and want to use your iPod to transfer

 music from one to the other, or you only store your music and

 videos on your iPod and need to copy them back onto hard drive

 after a disk failure, you are out of luck! This is where it comes

 in: it allows you to

 transfer

 songs from iPod to Mac running OS X 10.4 or higher.

 

 

  

 

 

 Step 1. Run the recommended program and connect

 iPod to your Mac

 Launch iPod to Mac Transfer and connect your iPod to Mac



 and the program will detect iPod, then you will see all

 information about iPod device are shown in the program interface

 like the following picture.

 

 

  

 

 

 Step 2. Copy music from iPod to Mac

 Press on the "music" icon in the left pane to open the

 library/playlist that you want to transfer. And click on the

 "export checked files to local" button.

 

 

  

 

 

 Step 3. Specify a folder to save your music

 files.

 

 

 There is a pop-up windows and on the left panel you

 can select a local folder to save your music. Then click on the

 "Save" button to export music from your iPod to local

 folder.

 

 

  

 

 

 Step 4. After it finishes transferring music from

 iPod to Mac, you will see a pop-up information dialogbox.

 

 

 Now you have known how to

 transfer

 music from iPod to Mac. Why not just free download it and

 experience it fro yourself? Come on!
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 iPad 2 is so hot and popular now, and I think it's

 really the best solution for games and video/audio playback as a

 portable media player. But for share DVD videos on iPad 2, we

 have to rip DVD to iPad 2 first. Then,

 how

 to convert DVD to iPad 2 is the problem we have to

 solve.

 

 

  

 

 

 Step 1 Run and import

 

 

 Run

 free

 dvd to ipad 2 converter. Click "load DVD" to import DVD

 chapters and titles from your computer to the program. After the

 DVD movie is added, all titles are listed.

 

 

  

 

 

 Step 2 Output Settings for iPad, iPad 2

 

 

 Set the output format - from the "Profile" drop

 down list, choose iPad > iPad H.264 Video(*.mp4).

 

 



  

 

 

 Step 3 Start to convert at "Start"

 

 

 That's it. The whole

 DVD

 ripping process for iPad, iPad 2 would last for about 20

 minutes - 1 hour. If your conversion takes too long time, learn

 how to speed up DVD movie to iPad conversion. When the conversion

 is done, you can approach the output file by clicking "Open

 Folder".
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 Forty-four percent of US children want an iPad

 under the Christmas tree: A lot to ask for in a country where

 46.2 million people, or nearly 15 percent of the population, live

 in poverty.

 

 

 In New York City, personally meeting Santa Claus is



 a lot easier than it sounds. Since November 25, four Santas have

 been available daily at the Macy's department store, from early

 morning until late at night, to hear children's pleas for what

 they want for Christmas.

 

 

 But it requires parents to navigate with their

 children through the huge store's eight floors.

 

 

 Those who really want to play it safe may wish to

 write a letter to Santa, and Macy's has a North Pole post box for

 just that purpose.

 

 

 Jasmine Morrobel, 9, knew what she wants to find

 under her tree: ''Dear Santa, I believe in you, and I want an

 iPad for Christmas. Yours, Jasmine from New York City.''

 

 

 The jolly old elf will certainly be familiar with

 the request:

 

 

 according to the market research institute Nielsen,

 44 percent of US children ages 6-14 want an iPad this year. Of

 course, most won't actually get one: the cheapest version of the

 Apple gadget costs 500 dollars.

 

 

 According to Nielsen, 30 percent of the letters to

 Santa from US children are topped by an iPod, while an iPhone

 appears on another 27 percent.

 

 

 Young Suri Cruise, of course, presumably has no

 budget constraints. The daughter of Hollywood stars Katie Holmes

 and Tom Cruise made headlines with her extravagant wish

 list.

 

 

 The US magazine In Touch cited her alleged letter

 to Santa, which reportedly listed a pony, diamond earrings and

 custom-made princess gowns as the 5-year-old's favorites. The

 items on Suri's Christmas wish list cost a combined 130,000

 dollars.



 

 

 Her parents have reportedly already bought the

 pony. Tom and Katie spare no expense to make Christmas as magical

 as possible for their little one, the magazine quotes a friend of

 the family as saying: They buy everything on her list.

 

 

  

 

 

 Related tips:

 download

 movies to ipad |

 ipad

 music |

 unlocking

 ipad
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 As we know, iPad 2 features two powerful cores in

 one A5 chip, that means users can get more wonderful experiences



 while surfing the web, gaming, and going from app to app,

 watching movies. So if you are thinking of buying an iPad 2, you

 can hardly wait to watch your favorite videos with it. Like iPad,

 Apple iPad 2 only supports H.264, MPEG-4 in MP4, MOV, M4V video

 formats. That's to say, you need to

 convert

 video to iPad 2 compatible format first.

 

 

  

 

 

 Step 1: Add video file

 

 

 Free Download the

 ipad

 video converter (

 ipad

 video converter for mac ) install and run it. Hit "Add File"

 button to import video file you want to play on iPad 2.

 

 

  

 

 

 Step 2: Set iPad 2 MPEG-4 format and iPad 2

 supported resolution

 

 

 Click the drop-down button on the right side of the

 "Profile" to select MPEG-4 Video (*.mp4) as output format. Then

 press "Settings..." button to select wanted resolution like

 640*480 or 720*576 or 1280*720 from the drop down list of

 Resolution or define your desired video resolution by overwriting

 the existing one.

 

 

  

 

 

 Step 3: Convert video to iPad 2 compatible

 video format

 

 

 press "Convert" button to finish converting video



 to iPad 2 supported video format.
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 YouTube.com is a great resource. YouTube allows

 users to freely upload, view, and even share video clips on your

 blog or web site. Now the new iPad is a much better device to

 videos on than any previous version of the iPod and iPhone, there

 are many people curious about how to get their YouTube video

 files into a format that the iPad/iPad 2 can play. Thankfully,

 there are a slew of sites and software packages that will allow

 you to convert just about any video format to the H.264 mp4

 format that iPad/iPad 2 requires.

 

 

  

 

 

 The tutorial shows you how to

 download

 YouTube videos to iPad, and convert YouTube videos to iPad

 video format for playback on iPad/iPad2. DVD to iPad Converter

 features a built-in Free YouTube downloader for iPad, which

 allows you to download videos from YouTube to iPad

 directly.



 

 

  

 

 

 1. Click the "YouTube" button in the main interface

 of

 free

 dvd to ipad converter to start the built-in YouTube to iPad

 app. In the pop up dialog of "Import Video from Internet", paste

 the URL of the YouTube video you copied just now.

 

 

  

 

 

 2. If you want to watch the downloaded videos from

 YouTube on iPad, you can choose MP4 as output format from the

 built-in YouTube downloader, then sync the downloaded MP4 files

 to iPad from iTunes.

 

 

  

 

 

 Other help:

 copy

 ipod to pc
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 The iPhone 4S is like its earlier version as far as

 external features are concerned. However, with the new processor

 and A5 chip and iOS 5, iPhone 4S is the best gadget in the market

 for game lovers. Now playing a game in your iPhone 4s set will be

 faster with cleaner, crisper graphics. Frame rates, game loading,

 and launch times are better as compared to iPhone 4 version. We

 choose 5

 best

 iPhone 4S games for you.

 

 

  

 

 

 1. Dead Space

 

 

 Dead Space should be a household name to any

 hardcore gamer. The series offers such a compelling horror feel

 and story that the iOS game is a strong companion to the console

 versions of the game. Dead Space on the iOS was made to promote

 and hype up the launch for Dead Space 2 but managed to stand out

 on its own as a great horror title, with crisp graphics and

 dropping onscreen buttons for a full view of the game.

 

 

  

 

 

 2. Machinarium 

 

 

 Machinarium is a rare game that stands out in a sea

 of clones and sequels. First making its release on the PC back in

 2009, Machinarium has finally made it's way to the iOS. It plays

 very much like an old school point-and-click adventure. Needless

 to say, it fits right at home on the iOS. 

 

 

  

 

 

 3. Rage HD



 

 

 While Rage has just launched to consoles, Rage HD

 has been out for awhile to offer players a small teaser of the

 full title. Even though the game has already been released, Rage

 HD is still a great game to pick up and play for the iPhone

 4S. 

 

 

  

 

 

 4. Asphalt 6: Adrenaline 

 

 

 Asphalt 6: Adrenaline is a racing game. While I'm

 unable to expand too much on what the game is about, I'll say

 simply that it's a great game for what it offers. 

 

 

  

 

 

 5. Spider-Man: Total Mayhem

 

 

 Developed by Gameloft, Spider-Man Total Mayhem lets

 you experience a day in the life of Peter Parker. Take on some of

 the daily tasks and errands that pop up in the city as you swing

 from building to building. While this game may not have much of a

 storyline (or character development, for that matter), the web

 action and boss fights make up for it.

 

 

  

 

 

 Related articles:

 how

 to put videos on iphone 4 |

 dvd

 to iphone 4 mac
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 Apple first sold all of us on the digital music

 revolution using the slogan "Rip, Mix, Burn." Indeed, thanks to

 Apple software, it was suddenly dead simple to copy and burn

 music CDs using your Mac. But what about video DVDs? It turns out

 there are a few hoops to jump through, but in the end, it's

 pretty easy, even though you may need to invest in some

 additional software.

 

 

  

 

 

 Before burning DVD, you must confirm the Burn DVD

 Mac has been installed and the blank DVD-R/DVD+R/RW/-RW

 

 Step 1: Run the software

 Start the

 mac

 dvd burner or

 mac

 dvd creator software, and you will see the following friendly

 interface.

 

 Step 2: Load Video files to burn.



 You can add video files by clicking the Add buttonhow "+"

 to burn dvd mac to load video files or clicking the "File" menu

 and then "Add Video".

 

 Step 3: Check the added video files

 Preview the added file in the preview pane to check the

 file. If you don't want to add it ,you can delete the selected

 file by pressing the Delete key "-" how to burn dvd macon the

 keyboard.

 

 Step 4: Edit Video Files

 The software support powerful edit functions. You can trim

 and crop the video files and adjust the effects before burning

 the videos to DVD on Mac OS X.

 

 

  

 

 

 Step 5: Edit DVD Menu

 The DVD Burner for mac also allows you to create your own

 DVD menu with various built-in resources. Click the Menu

 buttonhow to burn dvd mac on the bottom right of the main

 interface to edit the DVD's menu.

 

 Step 6: Select DVD type and the output quality

 Before burning your DVD, you can select your DVD type and

 the output quality at the bottom of the main interface. When you

 choose different formats or qualities the recoding time of the

 DVD is different.

 

  Step 7: Burning

 Check the above settings and then click the Burn button to

 set burning settings and burn your DVD project.

 

 

 

 

 Related help:

 dvd

 to avi mac
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 The iPad is the first tablet computer developed by

 Apple Inc. It is part of a device category between a smart phone

 and a laptop computer. The following tutorial is going to show

 you

 how

 to get movies on ipad.

 

 

  

 

 

 In order to watch the DVD movies, what you need to

 do is simply rip the DVD movies into a video/audio format

 supported by iPad. After you have the files in a compatible

 format upload them into your iPad through the sync of iTunes

 Library.

 

 

  

 

 

 Step 1. Insert the DVD that you want to put on your

 iPad and run

 dvd to

 ipad ripper.

 

 

  

 

 

 Step 2. Click "Add DVD" to import the DVD.



 

 

  

 

 

 Step 3. Select iPad compatible video format, such

 as Apple iPad H.264 Video, Apple iPad MPEG-4 Video or Apple iPad

 HD Video (720p).

 

 

  

 

 

 Step 4. Select a output file directory and press

 "Start" to

 rip dvd

 to ipad.
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 Upon receiving her new MacBook Air, my mother asked

 me how she's supposed to watch movies on the plane without a DVD

 drive. If you've got people asking you similar questions, here

 are some easy-to-follow instructions for ripping a DVD to your

 computer.



 

 

  

 

 

 Ripping a movie to your hard drive can seem like a

 complicated task, but it's actually pretty simple. There are a

 lot of ways to do it and a lot of different programs out there,

 but our favorite method uses a program called

 free

 dvd decrypter. It's pretty easy to use, and available on both

 Windows and Mac. The video above should walk you through the

 process, but you can follow along with these instructions.

 

 

  

 

 

 Step 1: Download and run the software.

 

 

 Step 2: Click "DVD" button to load your DVD files

 that you want to rip for your computer.

 

 

 Step 3: Click the "Profile Setting" combo box to

 choose a suitable video format like VOB HD as your output

 choice.

 

 

 Step 4: Click "Start" Button to begin to ripping

 processes.

 

 

 Step 5: Get the ripped video files via clicking the

 "Find Target" button and then you can play the DVD videos on your

 computer now.

 

 

  

 

 

 With

 dvd

 ripping software free, you just need five easy steps and then

 you can solve how to



 rip

 dvd to computer, which is easy for every user.
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 When Apple announced the iPad, I immediately

 imagined that it would be a superior way to read PDF books in a

 tablet-style format. On the Apple iPad Specs page, there is a

 single mention of PDF support for the iPad - in the Mail

 application as an attachment. However, there must be a way to

 view PDF files on the iPad natively, right? Let's walk through

 two main ways currently available to

 view

 pdf on ipad.

 

 

  

 

 

 Built-In PDF Viewing

 

 

  

 

 

 Mail Application - The iPad supports viewing PDF

 files that are sent as attachments via email in the Mail

 application. Simply download the attachment, click to launch, and



 you can view the PDF.

 

 

  

 

 

 Safari Web Browser - Also, selecting a link to a

 PDF file in the Safari web browser will also allow you to view an

 image inline.

 

 

  

 

 

 In both cases, notice that there is a border around

 the pages in the PDF content. I would prefer to have the content

 take up more of the screen. No problem - just pinch and zoom in

 to hide the borders. This choice is remembered as you navigate to

 subsequent pages.

 

 

  

 

 

 There are limitations to the built-in support,

 however. If you reopen a PDF file, it does not maintain the

  last read page location. And if there are clickable links

 in the PDF, such as in the Table of Contents, you cannot click on

 them. So, you're stuck scrolling down potentially hundreds of

 pages to get to the location you want.

 

 

  

 

 

 Ideally, I would like to see Apple include their

 Preview application on the iPad. Even if it was only a PDF viewer

 and did not allow changes to PDFs, being able to jump directly to

 a particular page and use general PDF navigation would be

 helpful.

 

 

  

 

 

 Related article:



 copying

 pdf to ipad |

 edit

 pdf on ipad
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 I found iPod Touch photos backup can be so easy

 when I used this handy iPod Touch photos to computer transfer

 software. With it, you can easily copy your save photos on your

 iPod Touch to any folder on your computer.

 

 

  

 

 

 Why so many users choose this

 ipod to pc transfer

 program:

 

 

  

 

 

 - Works with all iPod models: iPod Touch, iPod

 nano, iPod mini, iPod shuffle, iPod classic.



 

 - Auto-scanning: Auto-scans your iPod device, and display

 all your photos on tansee software screen.

 

 - View photos: You can view photos on your computer in two

 different size, big or small.

 

 - Backup photos in different resolution:

 transfer

 photo from ipod to pc in three resolution: big, middle,

 small. Tansee iPod Transfer Photo backup your photos in full

 resolution.

 

 - Read .ithmb files: Convert the .ithmb Files on your

 computer Hard Driver into JPEG or BMP Copy your .ithmb files and

 the associated "Photo Database" to a disk (for example D:) in

 structure as below: D:PhotosPhoto Database (Driver D: can be

 other one) D:PhotosThumbs*.ithmb (All your ithmb files) Then run

 Tansee iPod Transfer Photo, you can transfer photos out.

 

 - Backup to any folder: You can easily and quickly back up

 your photos from your iPod and

 transfer

 files from ipod to pc, iPod touch to any folder on your PC.

 

 And what's more important, it's Easy to use. And there are

 very good Options Setting when transferring the iPod Touch photos

 to Computer.
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 Adobe & Apple have been at logger-heads since

 Steve Job's refused to integrate the Flash Player into his

 Products.

 

 

  

 

 

 But there is good news on the horizon, as now it

 appears Flash Video can be used on the iPad with a helping

 hand.

 

 

  

 

 

 This helping had comes in the form of the jailbreak

 app named Frash. This app will allow

 play

 flash video on ipad. It appears this will work only on a

 jailbroken iPad.

 

 

  

 

 

 "Frash is able to run almost

 all Flash programs natively in the MobileSafari browser,"

 said Comex, which also created the Spirit untethered jailbreak

 tool for the iPhone, iPad and iPod touch,  in the

 description for the YouTube video created to show the hack in

 action.

 

 

  

 

 

 Pocket Lint, the company added that support for

 other devices, except 3GS+ only due to technical restrictions,

 will come shortly. Support for iOS 4 is also planned.

 

 

  



 

 

 Related article:

 transfer

 dvd to ipad |

 how

 to put dvd on ipad
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 The iPad has received positive reviews from both

 amateur and pro musicians, who seem to have found its touchscreen

 interface extremely convenient to work with during live shows and

 even in the studio. Many music software makers have realized the

 potential of the iPad as a musical instrument and released

 tablet-friendly versions of their respective software.

 

 

  

 

 

 1. MadPad HD

 

 

 MadPad HD is, at its heart, an audio sequencer; a

 device to loop sounds in order to create percussive or musical

 clips. However, it does so with miniature video clips recorded

 from, basically, anything. You can record 12 individual



 small clips of unique sounds, store them on your iPad (or in the

 cloud) and then play them back by tapping on each thumbnail. A

 basic looping function is included, plus you can record a larger

 sequence. You can also change the pitch and volume of each

 clip, effectively turning a person speaking into a Smurf or Barry

 White, or making a mundane noise, such as traffic, much more

 interesting. 

 

 

  

 

 

 2. Vevo

 

 

 If you like music videos, then Vevo is where it is

 all at and is pretty much an essential app for your

 collection. Land on the homepage and there is a carousel of

 several featured artists and videos. It's bold, it looks sharp

 and there is no messing around. Hit the one you want and the

 video streams, it's as simple as that.

 

 

  

 

 

 3. Sonos Controller

 

 

 This handy app acts as a free wireless music

 controller for your Sonos system. Download the app, install it,

 press a button on any one of your Sonos ZonePlayers and away you

 go. It really is that easy. IT enables you to manage your library

 remotely, and stream music to every room - you can either play

 different songs in each room or sync all your ZonePlayers to play

 the same song. Volume can be controlled via the hardware buttons

 on most Android phones.

 

 

  

 

 

 4. GarageBand

 

 

  This is the most fully functioning music app



 out there giving you what the majority of individual apps offer,

 but only better and in one package. You get to play piano,

 guitar, bass, drums, vocals, and if you've got the right dongle,

 even record your own guitar playing as well. Broken down

 into a number of different areas or instrument groups, the idea

 is that you can play your favourite instruments, lay down a

 track, and then edit and manage them into a song before exporting

 said track into iTunes or your desktop and then share it with

 your friends.

 

 

  

 

 

 5. SoundHound

 

 

 You've probably heard of Shazam. We mean, who

 hasn't? Shazam is a brilliant app and has rightly been massively

 successful in the app world. But what if there was an app

 that could do all of what Shazam could, but with added

 extras? Ah, but there is. SoundHound is like Shazam,

 but turned up to 11. It's Shazam's bigger, better

 looking nemesis, that not only recognises music that you

 play to it, it can also tag tunes that you sing and hum to it.

 And if you're too shy to sing or hum, you can even just speak the

 lyrics into it, or type them in if you're feeling shy.

 

 

 Related help:

 transfer

 music from ipad to mac |

 transfer

 music from ipad to computer |

 how

 to transfer songs from ipad to pc
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 I'm a big fan of the iPod but what I don't like is
 Apple not being very forthcoming about how to move music from the
 iPod back to the PC. They're quick enough to tell you how to
 transfer
 music from ipod to pc but when you want to do the opposite,
 Apple clams up tight.
 
 
  
 
 
 1. In Windows Explorer, go to Tools > Folder
 Options > View. In the Advanced Settings list, under Hidden
 files and folders, check the radio button for "Show hidden files
 and folders". Then click OK. You'll get a Windows security
 warning but it's safe enough to disregard it as we will only be
 disabling this function for a short while.
 
 
  
 
 
 2. Plug in your iPod. In Windows Explorer, a folder
 will now appear with the name of your iPod. Double-click on that.
 Go to the sub-folders "iPod_Control" and then "music". You'll
 find your music there randomly scattered across multiple folders
 and with scrambled file names. But don't worry, the ID3 tags are
 still fully intact and we are now going to "unscramble" the
 files.
 
 
  
 
 
 3. But first copy all the music from those iPod



 folders into a new folder on your hard-drive. Move all the songs
 into one single folder and discard all the folders that your iPod
 made. By the end, you should have one folder in your hard-drive
 with all the scrambled files together.
 
 
  
 
 
 4. Open up iTunes and do the following : Go to Edit
 > Preferences. Under the Advanced tab, under the General
 "sub-tab", select the local folder where you have copied the
 music from your iPod (by clicking Change…).
 
 
  
 
 
 5. In iTunes, click "File" then "add folder to
 library". Select the folder where all your copied music is.
 iTunes will now re-import all your music back into the playlists.
 But more importantly, because you have previously clicked "Keep
 iTunes Music Folder organised", iTunes will now start renaming
 and organising your songs into their correct names, albums and
 folders. This may take a while depending on how many songs you
 have in your iTunes library.
 
 
  
 
 
 Related article:
 copy
 files from ipod to pc |
 transfer
 movies from ipod to pc
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 WMV stands for "Windows Media Video", which is

 developed by Microsoft. WMV files are usually ASF files with a

 WMV extension. It can store video content in a compressed

 format.

 

 

  

 

 

 Though originally used for windows operating

 system, the WMV format has become very common. However, in this

 area, they always include DRM protection, that prevents illegally

 duplication. Unfortunately, Songs bought from different companies

 will have different DRM protection that can restrict you from

 playing videos on incompatible players. Also, DRM restrict the

 usage of computers, so you just can't share you DRM-laden music

 with your friends. There comes the headache!

 

 

  

 

 

 Step 1. Download and install the

 wmv

 drm removal.

 

 

 Step 2. Add WMV files

 

 

 Click on Add button to add the WMV files to the

 program.

 

 

 Step 3. Customize output settings and Start



 conversion

 

 

 Choose an output format from "Audio files to" or

 "video files to" area.

 

 

 Step 4. Start to remove DRM WMV

 

 

 The last thing is to click the "Start" button to

 start removing DRM from WMV files.

 

 

  

 

 

 Other help:

 how

 to put avi on ipod |

 how

 to put youtube videos on ipod
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 By default, iTunes is the only media player that

 you can use to sync your iPhone and iPod Touch with your

 computer. However, iTunes is only supported in Mac and Windows,

 which means Linux users with iPhones will have to find an

 alternative way to sync their iPhones, or at least get their

 music into the mobile device. In addition, there may be a large

 group of Windows users who are using other media players (such as

 Winamp) to manage their music library and loathe the idea of

 migrating the whole library to iTunes just because they bought an

 iPhone.

 

 

  

 

 

 Step 1: I know this may sound a bit ironic but

 you'll need iTunes installed so that CTM can find the drivers for

 your apple device. Also, you'll still need it for syncing apps.

 In case your iTunes is not up-to-date and you don't feel like

 downloading another 90MB just for drivers, then CTM has its own

 driver installer, which you can download here.

 

 

  

 

 

 Step 2: Download

 ipod to mac

 transfer. Once you save it to the desktop, run the software.

 It'll take some time to start, so be patient. You'll then be

 greeted to CopyTrans Control Center. From this list, select CTM

 (Free).

 

 

  

 

 

 Step 3: The CTM window will pop up with lots of

 blank windows. Simply connect your iOS device and you're all set.

 If all your drivers are installed, CTM will immediately recognize

 your device and display its content if there is any.

 

 

  



 

 

 Related article:

 transfer

 pictures from ipod to mac |

 transfer

 music without itunes mac
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 You have a portable video player and would like to

 watch your home video using it? Or you have to create a DVD for

 your home DVD player? Or you would like to convert a home video

 DVD to some other formats and save it on your PC? The

 mac

 video converter enables you to solve these problems quite

 easily with a few mouse clicks.

 

 

  

 

 

 The Video Converter lets you convert video and

 audio files from one format to another at top speed and with zero

 quality loss. It supports a wide range of formats such as AVI,

 MPEG, WMV, MP4, FLV, 3GP, MKV, and AVCHD etc. and offers a

 variety of presets for popular mobile devices like iPhone, iPad,

 iPod, HTC, PSP etc. Besides, this Video Converter software offers



 you series video editing functions including crop, trim, set the

 brightness, saturation, etc.

 

 

  

 

 

 â

 Convert video to different popular formats.

 

 

 â

 Extract audio or dialogue from movies or video

 clips.

 

 

 â

 Support portable devices like iPad, iPod, iPhone

 4S, PSP, Zune, Zune HD, etc.

 

 

  

 

 

 Relate tag:

 mac

 video to mp4,

 mac

 video to 3gp,

 mac

 video to avi
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 Do you want to download movies to ipad? Your Apple

 ipad is a really cool useful device. You can read books on your

 ipad, listen to music and download all kind of cool apps to it.

 One of the coolest and best features are that you can watch

 movies on your ipad. On this site we are going to tell you

 how

 to download movies on ipad.

 

 

  

 

 

 Typical aspects of iPad include portability and

 high quality output. It is comprised of various applications that

 are made more conducive for every user. Movie download for iPad

 doesn't need too much cost. In fact, it can be totally free of

 costs. Free movie download for iPad are highly recommended to

 experience its ultimate purpose. If you can't watch dvd, You need

 

 convert

 dvd to ipad.

 

 

  

 

 

 With the use of an internet, there are numerous

 legitimate sources wherein you can easily find free music and

 movies. You can automatically download these applications for

 your iPad, Android and any types of smart phones. Watching

 television movies and shows has now radically shifted from TV

 sets to iPad gadgets. You can watch plenty of TV shows as well as

 numerous channels such as Discovery Channel, CNN, NBC, Fox and

 HBO.

 

 

  

 

 

 The following are some basic procedures in



 downloading

 free

 movies for ipad 2. First, select your preferred movie file.

 You can browse the movie catalogue and just simply click it.

 Then, transfer your selected movies into your iPad.
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 iPhone

 to computer transfer is a robust and wonderful iPhone to

 computer transfer tool, it can transfer Music, Movie, Photo,

 ePub, PDF, iBooks, Audiobook, Voice Memo, Camera Roll (iOS 4

 above), iPhone Ringtone, Podcast, TV Show, SMS, Contact, Call

 List from iPhone to PC for backup or share with one-stop

 solution.

 

 

  

 

 

 With this professional

 transfer

 iPhone to new computer software, you will be able to create

 the "Tunnel" connects your iPhone to any PC disregard the

 restrictions of iTunes , safely sharing your iPhone's most recent

 music and videos and books, photos on another computer at any

 time.

 



 

  

 

 

 

 1.

       

 

Install the program properly, connect your iPhone to

PC correctly, and then start the program. It will show up an

interface as described in the image below.

 

 

 2.

       

 

On the left pane, locate to the exact catelog under

your iPhone playlist, choose a library and explore into the media

files inside it.

 

 

 3.

       

 

Find out the files which you want to transfer to PC

followed by ticks.

 

 

 4.

       

 

On the top menu, choose "Export - Export to Local" or

directly click "Export checked files to local" to indicate an

output folder, and then press "Save" to copy your files from iPhone

to the destination. Wait for a few mins and you can successfully

copy

files from iPhone to PC.

 

 

 5.

       

 

To edit your iPhone playlist, go to "File - Playlist"

and then choose "New Playlist" from submenu. You can use drag &

drop to import or export files easily.
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 The iPhone 4 is the fourth generation of iPhone,

 and successor to the iPhone 3GS. It is the first device to

 support FaceTime, Apple's video calling application. It has an

 Apple A4 processor, 512 MB of eDRAM, a 3.5 inches (89 mm) LED

 backlit liquid crystal display with 960-by-640 pixel resolution,

 and the iOS 4 operating system.

 

 

  

 

 

 The following guide shows you how to convert video

 AVI, FLV, WMV, MKV, 3GP, RM, RMVB, AVS to iPhone 4 video/audio

 files and transfer

 video

 to iPhone 4.

 

 

  

 

 



 Step 1: Download Video to iPhone 4 Converter

 

 

 Free download

 video to iphone 4

 converter which is a good video to iPhone 4 converter onto

 your PC. Install then run it.

 

 

  

 

 

 Step 2: Convert Video to iPhone 4 with one

 click

 

 

 Import videos to this iphone 4 converter. It

 supports more than 50 input videos formats. Then, select output

 video format as .mp4 (H.264, MPEG-4 video codec) from "Profile".

 Click "Convert" to begin video to iPhone 4 conversion.

 

 

  

 

 

 Step 3: Put the Converted Video to your Apple

 iPhone 4

 

 

 Connect your Apple iPhone 4 to PC and sync

 converted video to iPhone with Apple iTunes. Now you can

 watch

 movies on iPhone 4 and enjoy the fresh brilliance and high

 definition on its higher quality screen.
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 The iPhone 4 is the fourth generation of iPhone,

 and successor to the iPhone 3GS. It is the first device to

 support FaceTime, Apple's video calling application. It has an

 Apple A4 processor, 512 MB of eDRAM, a 3.5 inches (89 mm) LED

 backlit liquid crystal display with 960-by-640 pixel resolution,

 and the iOS 4 operating system.

 

 

  

 

 

 The following guide shows you how to convert video

 AVI, FLV, WMV, MKV, 3GP, RM, RMVB, AVS to iPhone 4 video/audio

 files and transfer

 video

 to iPhone 4.

 

 

  

 

 

 Step 1: Download Video to iPhone 4 Converter

 

 

 Free download

 video to iphone 4

 converter which is a good video to iPhone 4 converter onto

 your PC. Install then run it.

 

 



  

 

 

 Step 2: Convert Video to iPhone 4 with one

 click

 

 

 Import videos to this iphone 4 converter. It

 supports more than 50 input videos formats. Then, select output

 video format as .mp4 (H.264, MPEG-4 video codec) from "Profile".

 Click "Convert" to begin video to iPhone 4 conversion.

 

 

  

 

 

 Step 3: Put the Converted Video to your Apple

 iPhone 4

 

 

 Connect your Apple iPhone 4 to PC and sync

 converted video to iPhone with Apple iTunes. Now you can

 watch

 movies on iPhone 4 and enjoy the fresh brilliance and high

 definition on its higher quality screen.
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 Although a little clunky to set up, Hot Wheel's

 iNitro Speeders gives the option of using an iPhone to control

 its little remote control cars. The iPhone app includes the

 standard dual stick controller, but also lets you drive the car

 with the iPhone's accelerometer, choose a predefined driving

 pattern, or draw your own pattern.

 

 

  

 

 

 Push the control stick forward, and the car takes

 off like a shot. Hit the turn stick and it pulls 180s and 360s.

 The car is a little too fast, making it difficult to control.

 Instead of having the front wheels actually pivot, the car turns

 by torque, shifting power to the left or right.

 

 

  

 

 

 But the cool thing is the iPhone app controller.

 The car relies on infrared signals for its remote control,

 something not native to the iPhone. So Hot Wheels includes an

 infrared module that plugs into the iPhone's headphone port. It

 is not the most elegant solution, but it works.

 

 

  

 

 

 Hot Wheels says the iNitro Speeders are appropriate

 for children eight years old and up. Not many children that age

 own an iPhone, but many a parent hands over a phone for games.

 And although having to attach the control module to the iPhone is

 a little clunky, the app gives some interesting control

 possibilities. It also includes a built in racing game you can

 play anywhere.

 

 

  

 

 



 More article:

 convert

 dvd to iphone 4 |

 free

 dvd to iphone 4 converter |

 free

 movies for iphone 4
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 IGG Software, which is planning to release a

 version of its iBank financial software for the iPad sometime

 later this year, has teased a new feature of the unreleased app

 on its developer blog. The product now has a name -- iBank Access

 -- and will feature a new optional service to automatically keep

 bank records and the app in sync every time the app is launched.

 The new feature, which expands the number of institutions

 available, will be available by subscription.

 

 

  

 

 

 The program has largely been built by veterans from

 Intuit, the makers of Quicken who have had a spotty,

 on-again-off-again relationship with the Mac and iOS market.

 Intuit is presently planning to upgrade Quicken 2007 to make it

 Lion-compatible, which should be released on or around tax time.



 The iBank program has emerged as one of a handful of popular

 alternatives for people who can't find what they want from

 Quicken.

 

 The iBank developers also say they will be adding iCloud

 syncing compatibility into forthcoming editions, and maintaining

 Mobile Me iDisk compatibility until the service goes offline in

 June. IGG Software hopes to have the finished iBank Access for

 iPad out sometime during the summer.

 

 

  

 

 

 More ipad software:
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 ipad

 video converter |
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 Valentine's Day is a very special holiday and well,

 as always, there are lots of great apps for that. In fact, there

 are hundreds of applications for that and we continue to tell you

 about the best Valentine's Day iPad apps you might like or find



 useful for the most romantic day of the year.

 

 

  

 

 

 1. Send eFlowers

 

 

 All men should know that flowers really matter to

 the women, especially on Valentine's Day. If you can't buy or

 send flowers to your girlfriend, you can easily do this with Send

 eFlowers using your device. This app is among the best

 Valentine's Day iPad apps available in the App Store.

 

 

  

 

 

 2. Creative Romantic Ideas

 

 

 If you are looking for something different, here's

 one of the most romantic Valentine's Day iPad apps that might

 give you some fresh ideas to take your love's breath away. The

 good thing is that the app provides the ideas suitable for all

 budgets, so you shouldn't worry about money.

 

 

  

 

 

 3. Valentine's Day Recipes

 

 

 Probably everyone tries to make a Valentine dinner

 special. Fortunately there is an app that can help you to do

 this. This is surely one of the coolest Valentine's Day iPad apps

 that will help you to cook a tasty dinner for your

 sweetheart.

 

 

  

 

 

 iPad resource:



 free

 ipad movie |

 ipad

 songs |

 ipad

 ebooks
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 What if you have some DVD movies you want to enjoy

 on the iPad 3? This article explains you about how to rip and

 convert DVD to iPad 3 so that you can play your favorite DVDs on

 iPad3 easily. In terms of video/audio playback, there should be

 no much difference between iPad 2 and iPad 3. Apple's devices

 always support MP4 formats. So if you want to watch DVD movies on

 iPad 3, you will need to convert DVD to iPad 3 supported MP4

 formats. We use a

 dvd ripper which is one

 of the best and most professional DVD to iPad 3 converter.

 

 

  

 



 

 Firstly, free download and install this software to

 computer. Then choose the "DVD to iPad" button to open

 dvd

 to ipad converter.

 

 

  

 

 

 Secondly, just hit "Load DVD" to import DVD from

 your DVD ROM or DVD folder that you saved on Hard Drive.

 

 

  

 

 

 Thirdly, hit a suitable video format for iPad 3 in

 "Profile"drop down listing and preset the output destination by

 clicking "Output".

 

 

  

 

 

 Finally, just fire up the process through clicking

 "Convert".

 

 

  

 

 

 Tip:

 how

 to put video on ipad
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 This article will show different ways you can

 download free iPhone 4 movies downloaded to your iPhone 4 or iPod

 touch without breaking the bank.

 

 

  

 

 

 1. Locate free downloadable movies. There are

 several ways to download free videos over the internet. Many of

 these methods are either dangerous (can make your PC susceptible

 to viruses) or illegal. However, there are various legal ways to

 download free videos. You can find free downloads via the iTunes

 music store by choosing the free download category. You can also

 find services that charge a one-time fee for unlimited downloads.

 Finally, you can also locate free downloadable moves from

 bit-torrent sites, which are peer-to-peer sharing programs. This

 method, however, is not recommended.

 

 

  

 

 

 2. Download free movies. Once you have located a

 source to download your movie, simply download it and save it to

 a folder in your hard drive. It is recommended that you create a

 folder so that it will be easy to maintain and organize your

 files if you choose to download multiple movies.

 

 

  

 

 

 If iPhone 4 can't play the downloadable movies, you

 need



 rip

 dvd to iphone 4.For mac,

 dvd

 to iphone 4 mac is your best choice.

 

 
Security: Public

Location: Not Specified 
Mood: Not Specified 
Music:  
 

Thu, 16 Feb 2012
1:31 AM

 

Get Free iPod Touch Apps 
 

 

 

Normal

0

 

7.8 ???

0

2

 

false

false

false

 

 

 

 

 

 

 

 

 

 

 

 

 

 

MicrosoftInternetExplorer4

 

 

 

 



 

 

 

 

/* Style Definitions */

table.MsoNormalTable

{mso-style-name:????????????;

mso-tstyle-rowband-size:0;

mso-tstyle-colband-size:0;

mso-style-noshow:yes;

mso-style-parent:"";

mso-padding-alt:0cm 5.4pt 0cm 5.4pt;

mso-para-margin:0cm;

mso-para-margin-bottom:.0001pt;

mso-pagination:widow-orphan;

font-size:10.0pt;

font-family:"Times New Roman";

mso-fareast-font-family:"Times New Roman";

mso-ansi-language:#0400;

mso-fareast-language:#0400;

mso-bidi-language:#0400;}

 

 

 

 

 In the app world, phones get all the love-but what

 about the millions of iPod touch owners out there? We've got the

 same top-notch iOS operating system, and access to most of the

 same apps, but our needs are very different. For an app to be a

 must-have for the iPod touch, it needs to hit one of the

 following criteria: It should work well online and offline, since

 Wi-Fi isn't as widely available as an always-on cell connection.

 It should be fun, since entertainment is the iPod touch's first

 job. Here, music, movies, and games trump productivity. If you

 can't watch DVDs on iPod touch, the

 ipod

 touch converter can

 convert

 dvd to ipod touch video formats. That's not to say, though,

 that there aren't some great apps to help you get your work done.

 Lastly, it should either add a new feature to the touch, or make

 it do something even better-like make phone calls, for

 instance.

 

 

  



 

 

 The simplest way to get free iPod touch apps is

 very easy, you just need to type "Free iPod touch apps" or

 something related to it in your search engine such as Google,

 yahoo etc. the search engine will display thousands of websites

 that give you the option to enjoy downloading free iPod touch

 apps. You can select any appropriate website that suits you best

 and simple browse through it and get as many free iPod touch apps

 as you want. Internet is the simplest way to get free iPod touch

 apps since these iPod touch apps are virtual so they cannot be

 purchased from any physical store you have to download them

 through internet.

 

 

  

 

 

 Free iPod touch apps can be very useful too, since

 the apps are about anything and everything. Once you start

 browsing more and more apps from the internet you will find some

 amazing

 free

 apps for ipod touch such as Skype which is the best mean of

 communication these days, you can even get apps to maintain your

 physical fitness, not only this but to keep track of your daily

 routine you can download free iPod touch apps that can actually

 help you do it.
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   iPad is the latest PC tablet released by Apple,

   which has several unique and inventive features that makes iPad

   different from other contemporary tablet PC's. It can store

   huge mass of data including audio, video, image files,

   messages, web content etc. It is great for listening music,

   reading books, playing games, watching movies.

 

 

 

 

    

 

 

 

 

   iPad can easily get synchronized with PC through

   iTunes. But to transfer data faster from iPad to PC by using

   iTunes, which is not a good option because iTunes provides

   incomplete data transfer and it is not very fast as well. If

   you want to whole data transfer. You need to select effective

   software which will easily transfer the data such as music,

   videos, movies, images etc in fast and simple manner.

 

 

 

 

    

 

 

 

 

 Step1: Run

 

 

 

   ipad to computer

 

 

 



 (

 

 

 

   ipad to mac transfer

 

 

 

 ), and connect your iPad/iPod/iPhone to your

 computer via USB cable. After done, the iPad/iPod/iPhone icon and

 its library and playlists will appear in the Device

 list. 

 

 

 

    

 

 

 

 

   Step2: Open the library/playlist that you want to

   export files, and then check the file(s) you want to export in

   the file list.

 

 

 

 

    

 

 

 

 

 Step3: Click

 

 

 

   ipad to pc transfer

 

 

 

 to select the destination of the exporting files

 and start exporting files to Computer. Click to itunes to select

 the destination of the exporting files and start exporting files

 to iTunes. You could also choose the Export to local option from

 the Actions menu, and then export the files from your

 iPad/iPod/iPhone to actual device.



 

 
Security: Public

Location: Not Specified 
Mood: Not Specified 
Music:  
 

Wed, 22 Feb 2012
2:41 AM

 

Put Your iPod Touch Apps in a Folder 
 

 

 

Normal

0

 

7.8 ???

0

2

 

false

false

false

 

 

 

 

 

 

 

 

 

 

 

 

 

 

MicrosoftInternetExplorer4

 

 

 

 

 

 

 

 



/* Style Definitions */

table.MsoNormalTable

{mso-style-name:????????????;

mso-tstyle-rowband-size:0;

mso-tstyle-colband-size:0;

mso-style-noshow:yes;

mso-style-parent:"";

mso-padding-alt:0cm 5.4pt 0cm 5.4pt;

mso-para-margin:0cm;

mso-para-margin-bottom:.0001pt;

mso-pagination:widow-orphan;

font-size:10.0pt;

font-family:"Times New Roman";

mso-fareast-font-family:"Times New Roman";

mso-ansi-language:#0400;

mso-fareast-language:#0400;

mso-bidi-language:#0400;}

 

 

 

 

 iPod touch devices that use iOS 4.0 support the use

 of application folders. You can use folders to group all of your

 games, productivity software, browsers and social networking apps

 in their own categories so that you can access apps more easily.

 Folders also declutter the iPod's "Home" screen and can hold up

 to 12 apps per folder.

 

 

  

 

 

 Step 1

 

 

 Press down on the application you want to put in a

 folder until the app's icon wiggles and displays an "X" in the

 left corner.

 

 

  

 

 

 Step 2

 

 



 Drag the app and drop it on top of another app that

 you want to place in the folder. Your iPod will create a folder

 for both the applications. It will automatically assign a

 contextual name for the folder, which you can choose to change.

 Press the "Home" button to return to the list of apps.

 

 

  

 

 

 Step 3

 

 

 Drag other apps and drop them on the newly created

 folder to add them to the folder.

 

 

  

 

 

 Related read:

 how

 to put youtube videos on ipod |

 how

 to put dvd on ipod for mac
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 As we all know that there is a gap between the

 Apple Company and the Adobe Flash. We will see lots of news and

 arguments of Apple Company and Adobe flash, these two companies

 seems to have a lot of resentments. Just because of this reason,

 we can not play the Flash videos on Apple devices besides the

 latest iPad 2! Therefore, we can often see the attendant

 question, which is,

 how

 to play flash video on ipad or other Apple devices. I think

 all of us really hope that one day Apple devices will support

 playing Flash videos or one day the resentments between these two

 companies will be resolved!

 

 

  

 

 

 This helping had comes in the form of the jailbreak

 app named Frash. This app will allow Flash Videos to be watched

 on there iPads. It appears this will work only on a jailbroken

 iPad.

 

 

  

 

 

 "Frash is able to run almost

 all Flash programs natively in the MobileSafari browser,"

 said Comex, which also created the Spirit untethered jailbreak

 tool for the iPhone, iPad and iPod touch,  in the

 description for the YouTube video created to show the hack in

 action.

 

 

  

 

 

 Tips:

 download

 movies to ipad |

 convert

 dvd to ipad free
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 It seems odd to think of playing DVD movies on your

 Zune HD, but that's exactly what a DVD to Zune HD converter is

 designed for. Usually it can help you rip and convert DVD movies

 to Zune HD supported format such as MP4. However, when you want

 to enjoy the DVD movies in full screen on your Zune HD, the DVD

 movies usually come with the black bars. Can the DVD to Zune

 converter remove the black bars on the top and bottom of the

 movies?

 

 

  

 

 

 The

 dvd ripper free in the

 market is just the ideal program that helps you resolve these

 problems. It not only can

 convert

 DVD to Zune video or audio format, but also boast more

 functions than that, such as crop the black bars from DVD movies,

 merge multiple clips into large one, apply special effects, add

 watermarks, etc.

 

 

  

 

 

 Step 1. Import DVD movies

 



 

 Insert the DVD disc into the disc drive, click the

 "Open DVD" button to import it. Or if the DVD movie is saved as a

 folder on your computer, you need to click the "Add Video" button

 to locate that folder, which is composed of two separate folders:

 VIDEO_TS and AUDIO_TS. From the VIDEO_TS folder, select the .vob

 file to import and then click "OK".

 

 

  

 

 

 Step 2. Choose Output Format

 

 

 In the drop-down list of "Profile", navigate to

 "Zune" subcategory and choose the most appropriate profile as the

 output format.

 

 

  

 

 

 Step 3. Start converting DVD to Zune HD and

 transferring DVD to Zune HD

 

 

 Now you can click the "Start Encode" button to

 start converting DVD to Zune HD.

 

 

  

 

 

 Tip:

 convert

 dvd to ipad
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 "

 I have a lot of videos on my computer which i like very much,

 one day, my computer hard drive crashed, and all of them lost, i

 ask some professional person for help, but they said they can not

 help me, luckly i have almost of them on my iPad, now what i have

 to do is synch them to new computer, who can tell me how to

 transfer my favorite video to computer?"

 

 

  

 

 

 

   Step 1: Run Program

 

 

 After your iPad connected to your computer, launch the

 ipad

 to computer transfer. Normally, the program will search the

 device automatically. If the device is enabled, the files on iPad

 will be shown in the list.

 

 

  

 

 

 

   Step 2: Choose Videos

 

 

 Choose the videos you want to transfer from iPad to

 computer for backup.

 



 

  

 

 

 

   Step 3: Export Videos

 

 

 Click Export button on the top-left to start copy books to

 computer. You can copy to a disk folder or direct export to

 iTunes for backup.

 

 

  

 

 

 Related help:

 transfer

 photos from pc to ipad |

 transfer

 music from ipad to mac
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 With the sharpest, most vibrant, and

 highest-resolution display screen, we have to admit Apple iPhone

 4 is another great player for Apple lovers after the release of

 iPad. iPhone 4 owns a marvelous 960-by-640 resolution in a



 3.5-inch screen, which makes it a more gorgeous to enjoy movies

 and videos. But there are tons of different video formats in the

 market, do you know what video or movie format will your iPhone 4

 support? How to put

 video to iphone

 4?

 

 

  

 

 

 MP3

 

 

 The most common format for sharing songs and other

 audio is the MP3 format. MP3 files are compressed versions of an

 original audio track that remove inaudible portions of the

 composition to save space.

 

 

  

 

 

 AAC

 

 

 Files in the Advanced Audio Coding (AAC) format are

 the default audio format that Apple uses for its iTunes online

 music store, which provides the majority of the paid audio

 content to users of the iPod and iPhone.

 

 

  

 

 

 Other Formats

 

 

 The iPhone 4 also supports the Apple Lossless audio

 format, which attempts to provide music in the way the artist

 intended with zero quality lost from the original recording.

 These files are very large and are typically used by music

 aficionados or those that are major fans of a particular

 artist.

 

 



  

 

 

 Tip: How to put

 mkv

 to iphone 4? How to

 wmv

 to iphone 4?
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 Since iPods are basically big hard drives with

 special software and a screen, the hard drive in your iPod needs

 to be formatted. Formatting is essentially the process of

 prepping the drive to talk to the computer it connects to.

 

 

  

 

 

 Step 1

 

 

 Download and install the latest version of iTunes.

 If you already have iTunes installed on your computer, update it



 by clicking the "Help" menu and selecting "Check for

 Updates."

 

 

  

 

 

 Step 2

 

 

 Connect the Mac iPod to your Windows-based PC while

 iTunes is running. iTunes displays a message explaining it has

 detected an iPod formatted for Mac computers, and you must

 restore the iPod before you will be able to use it in Windows.

 Click "OK."

 

 

  

 

 

 Step 3

 

 

 Click the iPod in the blue column on the side of

 the iTunes application, and then click the "Restore" button in

 the main area of the window. iTunes formats the storage on the

 iPod to work with Windows. During this process, use the meter

 displayed on the screen to track the progress. When the format

 operation is complete, the iPod reboots and iTunes detects it

 again. You may now proceed with configuring the iPod to

 synchronize with your Windows-based PC.

 

 

  

 

 

 Related tips:

 transfer

 music from ipod to pc |

 transfer

 files from ipod to computer
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 The other day, when I was searching on the

 Internet, I found some people asking questions about reading

 PDF files on New iPad, some questions goes like this:

 

 

  

 

 

 "The iBooks application looks great, but I can't

 see anywhere whether or not it reads PDFs in the same way as it

 does ePub-formatted eBooks. Is this information available

 yet?"

 

 

  

 

 

 In fact, the iBooks app will probably only use

 ePub. Then you don't need to load PDF on New iPad via e-mail

 attachment in Mail app. While it's not a good reading experience

 of PDF content because it is not as much reflowable or smooth as

 ePub format on iPad. And you need to update iBook or

 iTunes.

 

 

  

 

 

 There are many programs to let you convert PDF to

 ePub so that you can read PDF on New iPad freely. Here we

 recommend you PDF to ePub Converter, a fantastic PDF to EPUB



 converting program, specially designed for Windows users,

 converts PDF to EPUB eBooks for iPad within a few seconds.

 Meanwhile, it is very easy to handle. Barely two or three steps

 can finish all the job.

 

 

  

 

 

 Tips:

 transfer

 videos to the new ipad |

 how to

 convert dvd to ipad

 

 
Security: Public

Location: Not Specified 
Mood: Not Specified 
Music:  
 

Wed, 14 Mar 2012
2:51 AM

 

Watch VOB Videos on iPhone 4 
 

 

 

Normal

0

 

7.8 ???

0

2

 

false

false

false

 

 

 

 

 

 

 

 

 



 

 

 

 

 

MicrosoftInternetExplorer4

 

 

 

 

 

 

 

 

/* Style Definitions */

table.MsoNormalTable

{mso-style-name:????????????;

mso-tstyle-rowband-size:0;

mso-tstyle-colband-size:0;

mso-style-noshow:yes;

mso-style-parent:"";

mso-padding-alt:0cm 5.4pt 0cm 5.4pt;

mso-para-margin:0cm;

mso-para-margin-bottom:.0001pt;

mso-pagination:widow-orphan;

font-size:10.0pt;

font-family:"Times New Roman";

mso-fareast-font-family:"Times New Roman";

mso-ansi-language:#0400;

mso-fareast-language:#0400;

mso-bidi-language:#0400;}

 

 

 

 

 I have some .vob videos that I want to put on my

 new iPhone 4. How can i do it?

 

 

  

 

 

 A professional

 iPhone

 4 Video Converter will be a good tool for iPhone 4. It can

 help you convert VOB to iPhone mp4 video even convert vob files



 to iPhone 4 HD video without any loss in quality. With this super

 VOB to iPhone 4 converter, directly add output video into iTune

 and transfer them to iPhone 4.

 

 

  

 

 

 1. Add VOB files to VOB to iPhone 4 software -

 Click "Add" button to import local VOB files or directly drag and

 drop VOB Videos to the program. batch conversion

 supported.

 

 

  

 

 

 2. Select iPhone 4 preset from format list and Set

 the output path: click on the "Format" bar, find iPhone group and

 select desired output format from the profile list like iPhone 4

 (* .mp4), and the resulting movie looks quite nice on iPhone 4's

 screen.

 

 

  

 

 

 3. Edit input files (optional)- powerful VOB to

 iPhone Converter can edit input videos such as trim the video

 length, crop the video playing area, adjust the video Effect

 (brightness, contrast and saturation), merge files into one, and

 add watermark, replace the original audio with other music and

 sounds file, etc.

 

 

  

 

 

 4.

 Convert

 VOB to iPhone 4- Make sure that you have checked the files

 you want to convert, and then click "Convert" button to start

 converting VOB to iPhone 4 compatible format.
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 Audiobooks are a great way to pass time while

 you're traveling or for experiencing literature if you don't have

 time to read books, but they are often several hours long and

 take up lots of space on your iPod. You will most likely find

 yourself needing to remove old audiobooks so you can fit new ones

 on your iPod.

 

 

  

 

 

 Step 1

 

 

 Plug your iPod into a USB port on your computer.

 iTunes should automatically open. If it doesn't, open it from the

 "Applications" folder on a Mac or from the "Start" menu on a

 Windows PC.

 

 

  

 

 

 Step 2

 

 

 Click on your iPod in the "Devices" list in the



 left side-panel in iTunes. Tick the check box next to "Manually

 Manage Music and Videos" and click "Apply" in the bottom-right

 corner.

 

 

  

 

 

 Step 3

 

 

 Click on "Books" underneath your iPod in the

 "Devices" list.

 

 

  

 

 

 Step 4

 

 

 Highlight the audiobook that you want to delete

 from your iPod. To highlight more than one audiobook at once,

 hold down "Ctrl" on a Windows PC or "Cmd" on a Mac and click on

 all of the audiobooks you want to highlight.

 

 

  

 

 

 Step 5

 

 

 Click on "Edit" in the menu bar at the top of your

 screen and choose "Delete." Your audiobook has now been deleted

 from your iPod but is still stored in your iTunes library.

 

 

  

 

 

 Tips:

 transfer

 pictures from ipod to mac |

 transfer

 music from ipod to itunes
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 There are many thousands of apps available. (As

 Apple's advertising campaign says, "There's an app for that.")

 But some apps are simply must-haves--whether for their

 functionality, interface brilliance, or sheer entertainment

 factor.

 

 

  

 

 

 

   Reeder

 

 

 

 Reeder is a $5 RSS reader, and if you're not yet on

 the RSS bandwagon, you should be. The app, which syncs via Google

 Reader, presents a gloriously elegant interface for reading the

 latest articles from your favorite Websites.

 

 

  

 

 

 



   Tweetbot

 

 

 

 Tweetbot began life as an excellent Twitter client

 for the iPhone, and the iPad version is even better. The $3 app's

 unique interface and brilliantly implemented gesture support make

 it not just a powerful app for reading and posting tweets, but a

 fun one, too.

 

 

  

 

 

 

   Flipboard

 

 

 

 Flipboard takes content you're interested in and

 presents it in an impressive magazine-inspired layout. The free

 app connects to your Facebook, Twitter, and Google Reader feeds,

 and also offers a variety of curated feeds in various categories

 like politics, technology, and entertainment.

 

 

  

 

 

 

   CNN

 

 

 

 Other news apps exist, but no free news app offers

 quite the polish of CNN on the iPad. The app combines videos and

 cleanly displayed articles to keep you abreast of all the news

 that's fit to consume.

 

 

  

 

 

 

   Dropbox

 



 

 

 Dropbox, a free Web service, lets you create a

 folder on your Mac that syncs automatically with whatever other

 computers you tell it to.

 

 

  

 

 

 More help:

 free

 ipad video converter |

 how

 to convert movies to ipad
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 When you purchase a new computer, one of your

 priorities may be to copy over all your iPod music. If you are a

 frequent iPod user, you may even have pictures, videos or other

 files on your iPod that you will wish to

 copy

 ipod to pc. A passing familiarity with iTunes and iPods will

 leave you aware that syncing your iPod with iTunes on your new

 computer will not have the desired effect. Doing so will leave

 both your iPod and iTunes empty.

 



 

  

 

 

 Step 1

 

 

 Click the "Start" button on your new computer and

 then "Control Panel." This opens a new window. Click "Show Hidden

 Files and Folders" in the "Folders" section, and then click "Show

 hidden files, folders and drives." Click "Apply" >

 "OK."

 

 

  

 

 

 Step 2

 

 

 Open iTunes, and then plug your iPod into your new

 computer. Click the "Cancel" button when iTunes asks whether you

 wish to sync your iPod with this computer. Find and click your

 iPod name where it is listed in the "Devices" section of iTunes'

 left panel. Click the "Summary" tab, and then "Manually manage

 music and videos" > "Enable disk use." Click "OK" in the box

 that opens for each of these options, and then click

 "Apply."

 

 

  

 

 

 Step 3

 

 

 Click "Start" > "Computer." Find your iPod in

 the list of drives, and then double-click on it. This displays

 folders containing everything on your iPod, including a

 "Contacts" folder and a "Photos" folder.

 

 

  

 

 

 Step 4



 

 

 Right-click on any folder or file you wish to

 transfer

 files from ipod to computer. Select "Copy" from the list that

 appears, and then right-click in the area of your new computer to

 which you wish to copy the folder or file. Right-click again and

 select "Paste." Repeat this step for each folder or file you wish

 to copy. To get to your music, double-click the "iPod_Control"

 folder and find the music folder inside.
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 9to5 Mac received the above image from a tipster

 located in Orlando, FL. The advertisement indicates both the 16GB

 and 32GB iPhone 4S models are available for $174.99, and $274.99.

 The $25 mark down applies to the 8GB iPhone 4 as well, which can

 be had for $74.99.

 

  Targets in Southwest Michigan don't appear to be running

 the same promotion, but that could be as much employees not

 caring to take the time to check. Still, the deal appears to be

 going on in Orlando till the end of the month. With 37 million



 iPhone 4Ss sold already I can't imagine retailers are sitting on

 massive amounts of inventory they need to push, which is why the

 Target deal is somewhat surprising.

 

  Although, the recent release of the new iPad has spurred

 price cuts of the iPad 2 with numerous locations selling one or

 more models cheaper than the already reduced prices. Micro Center

 has the iPad 2 16GB Wi-Fi model for $359.99 which is $40 cheaper

 than the recently reduced price of $400.

 

 

  

 

 

 Related help:

 rip

 dvd for iphone 4 |

 how

 to transfer music to iphone 4
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 The iPod Touch is a handheld multimedia device that

 allows users to connect to the Internet, play games, play music,

 watch and record high-definition video (720p) and communicate to



 fellow iPod Touch and iPhone 4 users via a Wi-Fi network

 connection (on-board camera and FaceTime features are available

 on 4th generation and later models) . The iPod Touch also

 features Bluetooth connectivity, allowing you to connect numerous

 Bluetooth devices including a headset or keyboard. Downloading

 games to your iPod Touch can be done using one of the two simple

 methods for app transfer and installation.

 

 

  

 

 

 Step 1

 

 

 Open iTunes on your computer and download the game

 you wish to purchase.

 

 

  

 

 

 Step 2

 

 

 Connect your iPod Touch to your computer using the

 included USB cable.

 

 

  

 

 

 Step 3

 

 

 Click on the iPod Touch device icon in the

 left-hand column of iTunes. This will sync your iPod Touch to

 your computer.

 

 

  

 

 

 Step 4

 

 



 Select the "Apps" tab in the iTunes menu and click

 on "Sync Apps."

 

 

  

 

 

 Step 5

 

 

 Choose the game applications you downloaded by

 clicking on the checkbox next to the icon. Click "Sync." This

 will transfer the game to your iPod Touch and install it. Once

 this is complete, the game icon will appear on your iPod Touch

 menu.

 

 

  

 

 

 Related help:

 convert

 dvd video to ipod touch |

 convert

 avi to ipod |

 convert

 divx to ipod touch

 

 
Security: Public

Location: Not Specified 
Mood: Not Specified 
Music:  
 

Wed, 28 Mar 2012
5:09 AM

 

Using iPhone 4 Settings to Keep Silent 
 

 

 

Normal

0

 

7.8 ???

0

2



 

false

false

false

 

 

 

 

 

 

 

 

 

 

 

 

 

 

MicrosoftInternetExplorer4

 

 

 

 

 

 

 

 

/* Style Definitions */

table.MsoNormalTable

{mso-style-name:????????????;

mso-tstyle-rowband-size:0;

mso-tstyle-colband-size:0;

mso-style-noshow:yes;

mso-style-parent:"";

mso-padding-alt:0cm 5.4pt 0cm 5.4pt;

mso-para-margin:0cm;

mso-para-margin-bottom:.0001pt;

mso-pagination:widow-orphan;

font-size:10.0pt;

font-family:"Times New Roman";

mso-fareast-font-family:"Times New Roman";

mso-ansi-language:#0400;

mso-fareast-language:#0400;

mso-bidi-language:#0400;}

 

 



 

 

 The iPhone 3 and iPhone 4 are cellular phones that

 are capable of sending and receiving phone calls, but they also

 can run applications and connect to the Internet. A headset can

 be plugged into the iPhone to enable private listening when

 desired. During situations that require silence, such as in a

 movie theater or meeting, the iPhone can be put in a silent mode

 that disables the ringing sound. If you forget to turn on the

 silent mode, a call's ring can be silenced quickly with one

 button.

 

 

  

 

 

 Step 1

 

 

 Press the "Home" button on the bottom of the iPhone

 to turn the screen on. Slide to unlock if necessary.

 

 

  

 

 

 Step 2

 

 

 Tap the "Settings" icon and choose "Sounds."

 

 

  

 

 

 Step 3

 

 

 Slide the On/Off switch to "Off" under the Silent

 heading to turn off vibrate completely if desired.

 

 

  

 

 

 Step 4



 

 

 Slide the On/Off switch to "Off" under the Ring

 heading to turn off vibrate when receiving an incoming call.

 Slide the volume slider all the way to the left to turn the

 ringtone down all the way.

 

 

  

 

 

 Related tips:

 how

 to put videos on iphone 4 |

 rip

 dvd to iphone 4
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 Android and iOS are surely IN now a day and people

 love to know about daily updates and apps of their choice. But it

 is a general routine that people mostly look for entertaining

 apps and due to the advanced graphics and efficiencies the gaming

 apps are offering, they mostly don't go for anything providing

 knowledge. Gaming is becoming more and more advanced so the hot

 trends and blogs are overloaded with gaming news, cheats, reviews

 and rumors. Today we are going to introduce you with a quite new

 and different application which offers something based on history



 and is definitely an eye-opening app.

 

 

  

 

 

 Complementing the TITANIC miniseries the TITANIC

 iPad app creates a unique integrated experience for fans of the

 series and amateur historians alike.

 

 

  

 

 

 The aim of the app is to extend the experience of

 the show into the hands of the audience, allowing them to dig

 deeper into the story and characters they love while accessing

 extra exclusive content and learning about the historical

 background behind the stories.

 

 

  

 

 

 The interactive TITANIC app consists of a

 three-part immersive journey that reveals the complexity of the

 tragic story, while enlightening and educating users about this

 hauntingly avoidable catastrophe. This digital triptych enables

 users to investigate, challenge, and relive some of the key

 decisions and turning points of the ship's history. Each section

 presents a unique immersive perspective on the timeless story of

 Titanic.

 

 

  

 

 

 Related tips:

 rip

 dvd to ipad mac |

 converting

 videos for ipad
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 The iPhone is a cell phone manufactured by Apple

 that plays music, shoots pictures and videos and can connect to

 the Internet over cell phone data networks and Wi-Fi. The iPhone

 can also run "apps" or applications. Each application must load

 in the iPhone's memory before you can use it. If too many

 memory-intensive apps are running at the same time, one or more

 of the applications may shut down without warning.

 

 

  

 

 

 The iPhone 4 has 512 megabytes of random access

 memory (RAM), which is where applications load and run. This

 memory is separate from the phone's storage capacity, which holds

 music, videos, pictures and apps. The iPhone 4 comes with either

 16 or 32 gigabytes of this system memory. Certain apps can

 consume greater amounts of memory as you use them. For example,

 the Safari web browser can open up to eight pages at once. If

 these multiple open pages require a lot of memory, another

 application, such as music or video playback with the iPod app,

 may suddenly close down.

 

 

  

 

 

 Related tips:

 convert



 mkv to iphone 4 |

 play

 dvd on iphone 4
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 I think the iPhone 4 is a great piece of IT

 engineering. Unfortunately, it was released at a time when hand

 held engineering marvels are becoming something of a commonality,

 what with Samsung, Nokia and other competitors offering their own

 top notch phones. For this reason, the iPhone 4 just didn't make

 such a big splash in sales.

 

 

  

 

 

 1.

 Facetime calling:

 Facetime, though very well received, yet the hassle of it working

 over only an active Wi-Fi hotspot is a problem. iPhone 5 is

 rumored to be featuring Facetime support over cellular

 services.

 

 

  

 

 



 2.

 Dual Power: every new

 smartphone being launched is offering a dual-core processor.

 Apple acquired PA Semiconductors last year, and a very possibly

 hint at a new dual-core architecture compared to the A4 single

 core architecture on the iPhone 4.

 

 

  

 

 

 3.

 Say cheese: Sony is said

 to be manufacturing a 8-megapixel for the 5th generation of the

 iPhone, while the iPhone 4 has a 5-megapixel camera with LED

 flash.

 

 

  

 

 

 4.

 HD support: the iPhone 4

 supports true 720p HD recording. The iPhone 5 is rumored to be

 having full 1080p support, with a micro-HDMI output on the

 side.

 

 

  

 

 

 5.

 NFC enabled: Rumor has

 it that the next-gen iPhone 5 will act as a Near Field

 Communications device, and thus may be acting as your payment

 device, or a car key.

 

 

  

 

 

 Related tag:

 dvd to iphone 4

 converter |

 dvd

 to iphone 4 mac
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 "Cube" is a first person shooter designed for

 Apple's iPod Touch portable device. Like all first person

 shooters, you see through the eyes of your character and fire

 virtual guns at enemies on screen. In addition to an offline

 single player mode, Cube allows you to use your iPod Touch's

 wireless Internet connection to play against other real live

 players all over the world.

 

 

  

 

 

 Step 1

 

 

 Press the home button on your iPod Touch to exit

 the "Settings" application and return to your main menu.

 

 

  

 

 

 Step 2

 

 



 Tap "Cube" to launch the Cube game on your iPod

 Touch. If you don't already have Cube, you can download it in the

 iTunes Store by selecting the "App Store" icon from your iPod

 Touch's menu.

 

 

  

 

 

 Step 3

 

 

 Select "Online" from the menu. This will start an

 online multiplayer session in Cube on your iPod Touch.

 

 

  

 

 

 Related:

 free

 ipod video converter |

 dvd

 to ipod touch
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How to Put DVD Movies on Your Kindle Fire? 
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 The all-new Kindle Fire adds the ability to watch



 movies, which broke through the Amazon Kindle's previous

 tradition to only read eBooks. With its Wi-Fi connected, we can

 watch movies, TV shows online. But what shall we do if we want to

 watch movies with no access to connect to Wi-Fi? For those who

 have already bought a lot of DVD collections will find that

 rip

 dvd to kindle fire supported MP4 format is one of the best

 solutions to save money.

 

 

  

 

 

 1. Load DVD Source

 

 

 Suppose you have downloaded this professional

 dvd to kindle fire

 converter and have it installed onto your computer, open it.

 Select "Load DVD" tab on the top tool bar to import your DVD

 movies to the program. (Make sure you have inserted the DVD disc

 into your DVD drive.) Besides, you can also load DVD Folder, ISO

 Files and IFO files, as per your need.

 

 

  

 

 

 2. Select Output Formats

 

 

 Click on "Profile" button and from the drop-down

 menu, you may select the targeted output format for your Kindle

 Fire. In case you are not sure, MP4 works perfectly on Kindle

 Fire.

 

 

  

 

 

 3. Rip & Convert DVD to Kindle Fire

 

 

 Before the final click, you can choose "Subtitle"

 and "Audio Track" according to your need. Once done with all

 settings, click on "Start" button on the right lower corner to



 start the DVD to Kindle Fire conversion.
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 Kindle Fire maybe the most striking tablet of

 Amazon. It is likely to be the first successful tablet not sold

 by Apple, and there are several good reasons for it: the low

 price of $199, the convenient, portable size of 7

 inches, and a rich catalog of books, movies and music

 offered through Amazon's Web-based services.

 

 

  

 

 

 1. Download this

 dvd to kindle

 fire.It's an excellent software which can convert DVD to

 Kindle Fire.

 

 

  

 

 

 2. Load DVD movies to this best



 dvd

 to kindle fire converter.The DVD to Kindle Fire converter

 supports loading DVD movies in flexible methods. Besides loading

 the entire disc from DVD-Rom, you can convert DVD IFO to Kindle

 Fire and convert DVD folders to Kindle Fire.

 

 

  

 

 

 3. Click the profile column and

 choose Android> Android MP4 Video (*.mp4) for

 output.

 

 

  

 

 

 4. Edit function is useful and convenient

 in Kindle Fire DVD Converter. After loading DVD files, you

 can use these functions below before download movies to Kindle

 Fire.

 

 

  

 

 

 5. Rip DVD movies to Kindle Fire MP4.Click convert

 button to start. The DVD movies to Kindle Fire

 converter will convert DVD videos to Kindle Fire for you

 with the best quality.
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Watch Your Favorite Video on Kindle Fire 
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 If you own a Kindle Fire, then you know it's really

 easy to watch video you rented or purchased from Amazon using the

 video tab on the home page. But how do you watch your own

 videos?

 

 

  

 

 

 First, get a micro-USB cable (the one on the left

 below). Amazon should have included one in the box, but they

 didn't. You can buy them inexpensively online.

 

 

  

 

 

 Connect your Kindle Fire to the computer using your

 micro-USB cable. It will go into a special mode that doesn't let

 you use the Fire until you tap the Disconnect button.

 

 

  

 

 

 You will see the Fire in Mac OS X Finder or Windows

 Explorer as a storage device.

 

 

  

 

 

 Drag the video from your computer to the Videos

 folder on your Fire.

 

 

  

 

 

 Related:



 kindle

 fire video converter |

 kindle

 fire video converter for mac
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